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A message from 
George Varanakis 
Do ever have a feeling that you’re about to be a 
part of something really big? I’m excited to wel-
come you to Photoshop Week at creativeLIVE! 
Get ready for 6 days, 13 incredible instructors 
and over 40 classes, all from the comfort of your 
computer – all for FREE. 

 Learn everything you ever wanted to know 
about Photoshop and Lightroom. Join in as our 
instructors debate techniques and explain how 
Photoshop can improve your business during 
group panel discussions. Ever wanted to see 
behind the scenes at creativeLIVE? During 
breaks, our instructors will act as roaming hosts, 
interviewing each other and maybe even your 
favorite creativeLIVE staffers.

We’re bringing back some familiar creativeLIVE 
faces – Lesa Snider, Ben Willmore, Kevin Kubota, 
Khara Plicanic, and Jared Platt. Plus, we’re going 
to introduce you to new instructors like Dave 
Cross, Jack Davis, Colin Smith and Aaron Nace. 
You’re going to love them, and I’m ready for all of 
those e-mails asking for them to come back.

 This is even more than over 66 hours of edu-
cation – it’s a LIVE interactive conference. Don’t 
just watch – join in! Ask questions in our chat 
room or on twitter. Join our facebook group. 
This is going to be the most fun you’ve ever had 
learning.

Photoshop Week is shaping up to be the big-
gest Photoshop event ever! Thanks for being a 
part of it.
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Good Work Habits
With Dave Cross

Portrait Retouching 
Essentials
With Lindsay Adler

Customizing Photoshop
With Dave Cross

Advanced Retouching 
Techniques
With Lindsay Adler

Getting Up Close and
Personal with Brushes
With Khara Plicanic

Retouching Plugins
With Lindsay Adler

Working with Text
With Khara Plicanic

Creative Retouching 
Techniques
With Lindsay Adler

General Efficiency 
Boosters
With Ben Willmore

Conquering  
Content- Aware
With Lesa Snider

Getting Started with 
Actions
With Ben Willmore

Practical Video Editing
With Lesa Snider

Up to Speed with the
Dec. 2012 Update
With Ben Willmore

Photoshop Unscripted
With Dave Cross

Group Panel:  
Technical Tuesday
Hosted by Dave Cross

Why Work  
Non-Destructively?
With Dave Cross

Work Smarter,  
Work Faster
With Dave Cross

Intermediate and  
Advanced Actions
With Ben Willmore

Mastering Blending 
Modes
With Ben Willmore

Understanding File 
Formats
With Khara Plicanic

Practical Creative 
Effects
With Lesa Snider

Fixing Common  
Problems
With Dave Cross

Combining Photos 
and Vectors
With Lesa Snider

Creating Expressive 
Masterpieces
With Jack Davis

Photoshop’s Best-Kept 
Secrets
With Colin Smith

~10 Photoshop Things 
You May Not Know About
With Jed Taufer

HDR: The Real and the 
Surreal
With Colin Smith

Editing Habits to Break
With Lesa Snider

Selections
With Jason Hoppe

Instant Global Optimizing: 
5-Step Tango to Perfection
With Jack Davis

Group Panel:  
Theory Thursday
Hosted by Jay Nelson

Retouching in No Time 
Flat
With Aaron Nace

Special Effects in  
Lightroom and ACR
With Jack Davis

Creative Compositing
With Aaron Nace

Quick Retouching in Lr & ACR 
- AND Photoshop, AND Back!
With Jack Davis

Thinking Outside 
the Box
With Joel Grimes

Lightroom Video Enhancing 
Secrets & Ps Integration
With Jack Davis

Thinking Outside 
the Box Part 2
With Joel Grimes

Making Your Workflow 
Flow
With Kevin Kubota

Presets, Presets,  
Presets!
With Jared Platt

Doin’ it Right in  
Lightroom
With Kevin Kubota

Extreme Synchronizing 
Techniques
With Jared Platt

Photoshoppa Bonanza
With Kevin Kubota

Portfolio Management
With Jared Platt

RoboTographer: The 
Art of Automation
With Kevin Kubota

Daily Uses for Publish 
Services
With Jared Platt

All Times in PST
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MONDAY FEB 25

Good Work Habits
With Dave Cross

There are many different ways to do things in 
Photoshop—this session focuses on strategies 
and techniques that are quicker, easier and 
more flexible. These methods not only help you 
get things done more quickly, but can increase 
your creativity since you can experiment and 
try different possibilities.

Portrait Retouching Essentials
With Lindsay Adler

In this segment, we’ll cover the basics of 
portrait retouching: cloning, the patch tool, 
teeth whitening, brightening eyes, and more. 
If you’ve been wanting to jump into portrait 
retouching but didn’t know where to start, this 
class is for you.

Customizing Photoshop
With Dave Cross

In this session we’ll cover a bunch of ways to 
make Photoshop look and operate the way 
YOU want, from customizing menus and short-
cuts to making presets and more. Once again 
the focus is on improvements that will make 
your life in Photoshop easier – every day, no 
matter what you do in Photoshop.

Advanced Retouching Techniques
With Lindsay Adler

This class takes portrait retouching to the 
next level. In this class we’ll cover advanced 
retouching techniques like frequency separa-
tion, liquify, and the warp tool. For people who 
understand the basics of portrait retouching 
and want to learn the more advanced ways that 
Photoshop can help improve your pictures.

Getting Up Close & Personal with Brushes
With Khara Plicanic

Big, small, hard, soft... brushes come in all 
shapes and sizes. This segment focuses on learn-
ing to manipulate various features of brush tools 
(not only the brush tool itself, but also other brush 
engine tools). Creating a finished project, we’ll 
incorporate various preset brushes as well as 
exploring how to make our own custom brushes.

Retouching Plugins
With Lindsay Adler

Sometimes Photoshop isn’t all you need: this 
class will cover various plugins and tools that 
can help you save time and be more creative 
with your retouching.

Working with Text
With Khara Plicanic

Above and beyond simply adding text, we’ll ex-
plore different type styling tools (kerning, lead-
ing, etc.), the differences between the various 
type tools, as well as some different ways to 
get the most out of your Photoshop typography. 
We’ll also talk about recommended resources 
for responsible typography.

Creative Retouching Techniques
With Lindsay Adler

Retouching isn’t just to fix blemishes—you can 
also use retouching techniques for creative 
reasons and to further your artistic vision. This 
class will cover techniques you can use to 
make your pictures really stand out from the 
crowd.
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TUESDAY FEB 26

Conquering Content-Aware
With Lesa Snider

Photoshop includes a slew of tools that sport 
Content-Aware technology for analyzing your 
images, and CS6 added even more. In this 
class you’ll learn practical, everyday uses for all 
of these tools including Content-Aware Scale, 
Content-Aware Fill, Content-Aware Move, and 
Content-Aware Patch.

Getting Started with Actions
With Ben Willmore

Learn how to automate repetitive or complex 
tasks by recording them as actions in Photo-
shop. You’ll learn everything needed to get 
started using Actions today as well as learning 
the most common issues that prevent them 
from being effectively implemented. See how to 
customize Actions to your personal needs.

Practical Video Editing
With Lesa Snider

Photoshop CS6 lets you edit video easily and 
efficiently. In this class, you’ll learn how to import, 
trim, & split video clips as well as apply adjustment 
layers for color correction or creative color effects. 
Get the scoop on adding edge effects with Layer 
Styles, using Solid Color Fill layers to fade intros 
and outros, as well as animate text and other graph-
ics to create compelling motion videos.

Up to Speed with the Dec. 2012 Update
With Ben Willmore

Adobe released over a dozen new features for Pho-
toshop CS6 in Dec. of 2012. Learn how to access 
these features and get the most of them.

Use Smart Objects with Blur Gallery and Liquify • 
CSS export for web design • Crop tool refinements • 
Conditional Actions • Changes to the Pen tool • Im-
proved type styles • Larger JPEG support• & more

Photoshop Unscripted
With Dave Cross

This is your opportunity to get solutions to your 
specific Photoshop problems! Need help with 
layers? Can’t clone out that tree? Warp or liqui-
fy? Send in questions on any Photoshop topic 
and Dave Cross will answer as many of them 
as he can, live!

Group Panel: 
Challenging Assumptions
Hosted by Dave Cross

General Efficiency Boosters
With Ben Willmore

Learn how to fly through Photoshop features with the 
utmost efficiency by taking advantage of all of Photo-
shop’s shortcuts, presets, customization & automa-
tion features. See how to access most of Photoshop’s 
features using your keyboard and how to customize 
the ones you use the most for greater efficiency. 
You’ll also learn about many hidden features!
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Why Work Non-Destructively?
With Dave Cross

Lots of people suggest working non-destruc-
tively but don’t really explain why. This session 
will show both how to and why work non-de-
structively, and will cover both the best meth-
ods to use, and how they can help you. We’ll 
cover Layers, Masks, Adjustment Layers, and 
introduce Smart Objects and Smart Filters.

WEDNESDAY FEB 27

Intermediate and Advanced Actions
With Ben Willmore

Learn how you can push actions to automate 
overly complex or difficult tasks. Use subroutines 
to make customization of complex actions easy. 
Learn how to implement the new conditional ac-
tions feature that Adobe introduced in late 2012. 
Also, get a glimpse of how you can overcome 
the limitations of actions with scripting.

Work Smarter, Work Faster
With Dave Cross

Everyone wants to work more efficiently (even 
if you charge by the hour) and this session 
will show you a ton of ways to get more done 
in less time. We’ll cover some powerful built-
in automated commends, actions and some 
not-so-obvious ways of speeding up your work. 

Mastering Blending Modes
With Ben Willmore

You’ve seen that menu... the one that includes 
choices like Multiply, Screen, Overlay & Hue. It’s 
found in many areas of Photoshop including at the 
top of the Layers panel. Learn how that single fea-
ture can open a new world of possibilities in your 
photo-editing tasks and design projects. See why 
blending modes are one of the single most useful 
features in all of Photoshop!

Understanding File Formats
With Khara Plicanic

Who says file formats can’t be sexy? People 
get all kinds of confused about file formats. 
JPG, PSD, TIF, PNG, EPS, PDF, etc. What’s the 
difference and when/why would you choose 
one particular format over another? Learn to 
understand your options within Photoshop!

Practical Creative Effects
With Lesa Snider

Get the scoop on turning your photos into unique 
pieces of art in this super creative yet practical 
session. You’ll learn how to apply creative color to 
your images to produce partial color effects, duo-
tones, and color overlays. You’ll also learn how to 
use Photoshop’s blur filters to produce gorgeous 
shallow depth of field and tilt-shift effects. Easily 
add edges to your images & more!

Fixing Common Problems
With Dave Cross

Submit your problem photos and Dave Cross 
will show different strategies to fix them! This is 
a chance to see real world solutions to your real 
world Photoshop problems.

Combining Photos and Vectors
With Lesa Snider

Learn how to easily combine illustrations with 
photography in this super creative session that 
pairs “real” with “surreal”. Glean the secret to im-
porting vectors into your document so you can 
experiment with them as backgrounds, artful 
embellishments, ornamental photo frames, and 
more — all without losing an ounce of quality!
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THURSDAY FEB 28

Creating Expressive Masterpieces
With Jack Davis

Expand your studio’s repertoire by turning your 
special photographs into creative paintings quick-
ly and easily with Photoshop – and you don’t have 
to be a Rembrandt to do it! Clients love artistic 
expressions of their families and pets – especially 
as large gallery wrap prints. Join Jack Davis as 
he shows you simple step-by-step techniques for 
transforming your photos into masterpieces.

Photoshop’s Best-Kept Secrets
With Colin Smith

Learn some of the best-kept secrets for amazing 
image results. Learn the most in-demand tech-
niques that will make your work look current and cut-
ting-edge. Here is where everything comes together 
and you experience that extra “something” that will 
elevate your imagery above that of the masses. 
Special effects, color treatments and other Photo-
shop Secrets are what this session is all about. 

Approximately 10 Photoshop Things You 
May Not Know About
With Jed Taufer

Been using Photoshop for years? Think you know 
everything that it can do? Jed Taufer would beg to 
differ! Jed will present approximately 10 things you 
can do with Photoshop that you may not already 
know about.

HDR: The Real and the Surreal
With Colin Smith

More than a regular photograph, more depth, more 
detail. This dynamic session teaches you exactly 
what is and what isn’t true HDR. Colin has been an 
HDR pioneer for 8 years and has created official 
training for HDR Soft (makers of Photomatix) and 
he will show you how to craft a work of art with 
High Dynamic Range photographs using Adobe 
Photoshop.

Editing Habits to Break
With Lesa Snider

Each version of Photoshop comes with new features 
that let you work faster and more efficiently, and CS6 
is no exception. Unfortunately, old editing habits can 
be hard to break. In this session you’ll learn when 
to use adjustment layers in place of pixel-based or 
duplicate layers, when to use Shape tools and vector 
masks in place of selection marquees & pixel-based 
masks, how to handle repeating elements, and more. 

Selections
With Jason Hoppe

In this segment, learn all about selections! Using 
the lasso, polygon lasso, magic wand, and quick 
selection tools, then using the Refine Edge tool to 
perfect the selections—then learn to save them as 
channels. Also, learn to effectively use the quick 
mask tool!

Group Panel:
The Business of Photoshop
Hosted by Jay Nelson
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FRIDAY MARCH 1

Instant Global Optimizing -  
The 5-Step Tango to Perfection
With Jack Davis

Miracle Enhancing, Effects & Retouching - in Ado-
be Lightroom or Photoshop’s Adobe Camera Raw! 
Glamour retouching in Lightroom? Incredible Hand 
Tinting in Adobe Camera Raw? Blurring your back-
ground with a non-destructive brush? That’s right 
- you don’t NEED Photoshop for the vast majority of 
your photographic magic! 

Retouching in No Time Flat
With Aaron Nace

Learn a step-by-step workflow to cut your retouch-
ing time! Plan your changes, prep the images, 
do basic color correction, remove distractions, 
capture skin texture, paint in new skin (while 
preserving texture), work on the details (eyes, lips, 
and hair), then make global changes—all in no 
time flat.

Special Effects in Lightroom and ACR
With Jack Davis

Miracle Enhancing, Effects & Retouching - in 
Adobe Lightroom or Photoshop’s Adobe Camera 
Raw! Glamour retouching in Lightroom? Incredible 
Hand Tinting in Adobe Camera Raw? Blurring your 
background with a non-destructive brush? That’s 
right - you don’t NEED Photoshop for the vast 
majority of your photographic magic! 

Quick Retouching in Lightroom and 
ACR - AND Photoshop, AND Back!
With Jack Davis

Miracle Enhancing, Effects & Retouching - in 
Adobe Lightroom or Photoshop’s Adobe Camera 
Raw! Glamour retouching in Lightroom? Incredible 
Hand Tinting in Adobe Camera Raw? Blurring your 
background with a non-destructive brush? That’s 
right - you don’t NEED Photoshop for the vast 
majority of your photographic magic! 

Lightroom Video Enhancing Secrets  
and Photoshop Integration
With Jack Davis

Miracle Enhancing, Effects & Retouching - in 
Adobe Lightroom or Photoshop’s Adobe Camera 
Raw! Glamour retouching in Lightroom? Incredible 
Hand Tinting in Adobe Camera Raw? Blurring your 
background with a non-destructive brush? That’s 
right - you don’t NEED Photoshop for the vast 
majority of your photographic magic! 

Creative Compositing
With Aaron Nace

Use compositing to subtly or not-so-subtly make 
your photos look amazing! Learn to cut your sub-
ject out, prep the background, match foreground 
and background, fix shadows and highlights, color 
the image, then add finishing touches and styling 
to the image.

Thinking Outside the Box
With Joel Grimes

Experiment with alternative ways of creating! Create 
shallow Depth of Field using ND filters and Strobing 
outdoors. Increase your Mega Pixels—make a 22 MP 
camera into a 50 MP! Create a lens perspective that 
does not exist in one image. Stack images to create 
long exposures without the risk of noise, take out 
movement, double or multiple exposures to create 
painterly images, and increase your Depth of Field.

Thinking Outside the Box Part 2
With Joel Grimes

Experiment with alternative ways of creating! Create 
shallow Depth of Field using ND filters and Strobing 
outdoors. Increase your Mega Pixels—make a 22 MP 
camera into a 50 MP! Create a lens perspective that 
does not exist in one image. Stack images to create 
long exposures without the risk of noise, take out 
movement, double or multiple exposures to create 
painterly images, and increase your Depth of Field.
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SATURDAY MARCH 2

Making Your Workflow Flow
With Kevin Kubota

Use organization when and where it counts: 
before you become disorganized. Set up folder 
templates and client tracking systems. Create 
starter presets to use in your Lightroom workflow, 
making you stupendously faster. Then use Light-
room for super fast editing and organizing. Trim 
the fat from your workflow!

Presets, Presets, Presets!
With Jared Platt

Never Do It Twice: Using presets everywhere in 
Lightroom, from import to export. This class will 
cover synchronizing presets, creating presets, 
preset organization, and making your preset col-
lection efficient through naming and organization. 

Doin’ it Right in Lightroom
With Kevin Kubota

Learn essential shortcuts, which Lightroom 
adjustment tools are most useful, and how to 
properly use them. Discover how to achieve MTQ 
(Magical Tonal Quality) Nirvana and other mythi-
cal tips. Then let’s build some amazing enhance-
ment presets together! Then bring everything 
together and work hand-in-hand with Photoshop.

Extreme Synchronizing Techniques
With Jared Platt

Getting in Sync: Everything you need to know 
about synchronizing in the develop module.
Beyond Sync: Mastering relative adjustments for 
changing exposures and color balance.Bringing it 
Home: Bringing your on-location decisions home 
to insure consistency of selection and style. Syn-
chronizing Catalogs: Using Lightroom on the road, 
across the ethernet, or between photographers.

Photoshoppa Bonanza
With Kevin Kubota

Overcome your fear of the Photoshop beast! 
Learn what you really need to know about CS6. 
Say it with me, “Yes I can!” Learn color man-
agement for those that are scared of the words 
“Color Management”. Clarify what has to be 
done in Photoshop vs. Lightroom. And learn how 
to C.R.E.a.T.E! (Clean, Retouch, Enhance, and 
Tweak Easily)

Portfolio Management
With Jared Platt

The Portfolio: An introduction to the Lightroom 
portfolio design. The Auto Portfolio: Automating 
your portfolio for effortless portfolio updates.
Finding Images: Using keywords, smart collec-
tions and metadata for quick images retrieval. 
Sharing Images: Quick and easy ways to share 
your portfolio images with the world.

RoboTographer: The Art of Automation
With Kevin Kubota

Become the Boss of Batch Processing! Learn 
how to write your own Photoshop actions that 
actually work…all the time. Master the LR–PS–LR 
Roundtrip. Create export presets in Lightroom 
and use the Publish services. Then discover how 
to quickly prepare images for a variety of presen-
tation methods, from online to print.

Daily Uses for Publish Services
With Jared Platt

Wedding Day Slideshows: Creating wedding 
slideshows for the laptop and the iPad at the 
wedding. Studio Portfolio: Using publish services 
to maintain up-to-date studio portfolio displays.
Facebook It: Keeping the world talking about 
your images with the touch of a button. Make 
Them Smart: Using smart folders in publish ser-
vices for hands off image publication.
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INSTRUCTORS
Dave Cross
For 25 years, Dave Cross has been helping photographers and creative profession-
als get the most out of their Adobe software. Since1987, Dave has taught Photoshop, 
Illustrator and InDesign to thousands of users around the world. He has a Bachelor of 
Education, is an Adobe Certified Instructor in Photoshop CS6 and is a Certified Techni-
cal Trainer. Dave has taught for Adobe, at Photoshop World, the Texas School of Pho-
tography, the Santa Fe Workshops, Imaging USA and at numerous corporate locations. 
Dave has written many articles and several books, co-hosted Photoshop User TV and 

has appeared in many DVDs and online courses for Kelby Training and udemy.com. He runs Dave Cross 
Workshops in his own studio/workshop space in Tampa, FL.

Over the last 13 years, Dave has taught Photoshop in every state in the United States, throughout 
Canada and in Europe, consistently earning rave reviews. Dave is well-known for his engaging style, his 
humor and his ability to make complex topics easy to understand. In 2009 Dave was inducted into the 
Photoshop Hall of Fame.

Lindsay Adler 
Lindsay Adler is a professional portrait and fashion photographer based in New York. 
Her editorials have appeared in dozens of publications internationally including Bullett 
Magazine, Zink Magazine, Fault and more. She regularly contributes to a variety of 
major photo publications including Professional Photographer, Rangefinder Magazine, 
and Popular Photography.

In May 2010 she published her first book, “A Linked Photographers’ Guide to Online 
Marketing and Social Media”. In February 2011, she published her second book, 

“Fashion Flair for Portrait and Wedding Photography.” Her third book “Shooting in Shitty Light” was pub-
lished in Oct 2012.

Adler, a Sigma Pro, is sponsored by a variety of major photography companies and spends a lot of her 
time traveling to teach workshops and at major conference. You can find her as a platform speaker at 
events like WPPI, Photo Plus, Imaging USA and many more. She teaches thousands of photographers 
annually on topics ranging from retouching, to fashion techniques, to studio lighting.

Though only in her mid-twenties, her career and photography have received much acclaim and she has 
already become a respected name in the industry. Her images have appeared in major publications, 
advertising campaigns, billboards and more.

Khara Plicanic 
A one-woman show, Khara has been dazzling clients with outrageous service and 
record-breaking turnaround times since shooting her first wedding 13 years ago. Her 
book, “Your Camera Loves You: Learn to Love it Back” (Peachpit Press) was released 
in August 2011, showcasing her unique teaching style and playful sense of humor that 
continue to endear her to an exponentially growing audience. She believes in good 
design, an efficiently effective workflow, and all things covered in chocolate. 
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INSTRUCTORS
Ben Willmore
�Ben Willmore is a member of the Photoshop Hall of Fame who has taught over 100,000 
Photoshop users on five continents. His bestselling books, DVDs, and hit seminars 
have established Ben as one of America’s favorite Photoshop instructors, and he is 
often the top-selling speaker at design and photography conferences throughout the 
world. He writes for numerous digital imaging publications, including Photoshop User 
magazine, and his award-winning books have helped helped hundreds of thousands 
of design and photography professionals make the transition from blindly following 
step-by-step techniques to “Ah-ha! I finally GET Photoshop!” 

Lesa Snider
Lesa Snider is on a mission to teach the world to create—and use!—better graphics. 
She’s an internationally acclaimed speaker and author of Photoshop CS6: The Missing 
Manual, Photoshop CS5: The Missing Manual, and coauthor of iPhoto ’11: The Missing 
Manual (Pogue Press/O’Reilly, www.lesa.in/lesabooks). Lesa is also a stock photogra-
pher and the founder of the creative tutorial site, PhotoLesa.com. She writes a regular 
column for Photoshop User, Elements Techniques, and Macworld magazines, and 
contributes frequently to Design-Tools.com and PlanetPhotoshop.com. 

Lesa is also a long-time member of the Photoshop World Dream Team of instructors and can be spotted 
teaching at many other conferences around the globe. She also teaches Advanced Photoshop for the 
international graphic design school, Sessions.edu. During free time, you’ll find her carving the twisties on 
her BMW sportbike, dressed up in her Star Trek best at a sci-fi convention, or hanging with fellow Apple 
Mac enthusiasts. Lesa is a proud member of the BMWMOA, F800 Riders Club, the Colorado Mac User 
Group (CoMUG.com), and the North Coast Mac User Group (NCMUG.com). 

Jack Davis
Best-Selling Author Jack “Wow” Davis is one of the world’s leading experts on Ado-
be Photoshop and Lightroom, as well as himself being an award-winning designer 
and photographer. Jack is coauthor of the bestselling (a million copies+ in 12 lan-
guages) guides to Photoshop, The Photoshop Wow! Book and How to Wow: Photo-
shop for Photography (Benjamin Franklin Award for Best Computer Book, Computer 
Press Assoc: Best How-To Book, International Digital Imaging Assoc: Most Useful 
Book).

For over 25 years Jack has been an internationally renowned spokesperson on digital imagery, and 
routinely teaches at conferences and workshops around the world. Davis was one of the first inductees 
into the Photoshop Hall of Fame for his lifetime contributions to the industry. Jack has an MA and MFA 
in Digital Imagery, and when he’s not in his studio in San Diego, he’s usually somewhere in Polynesia, 
camera and paint brush in hand, capturing the local color. 
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INSTRUCTORS
Colin Smith
Colin Smith is a best-selling author, trainer, and award-winning digital artist who has 
caused a stir in the community with his stunning Photoshop work. Colin is also known 
as a pioneer of HDR photography. Colin is an Adobe ACP (Adobe Community Profes-
sional), He is founder of one the world’s most popular Photoshop resource sites, Photo-
shopCAFE.com, which boasts over 30 million visitors.

With over 18 years of experience in the creative industry, Colin was formerly Senior 
Editor and Creative Director for VOICE magazine. He is a regular columnist for Photoshop User maga-
zine. He has been featured in most major imaging magazines including, Computer Arts, Macworld, After 
Capture, PSD Photoshop, Advanced Photoshop, Photoshop Creative, Digital Photographer, Web Design-
er magazine and a host of others.

Colin’s digital imaging work has been recognized with numerous awards, including, MacWorld Digital 
Design and 3 Guru awards at Photoshop World 2001 and 2002. He’s authored or co-authored more than 
eighteen books on Photoshop, including the best-selling How to Do Everything with Photoshop (Mc-
Graw-Hill/Osborne) and award-winning Photoshop Most Wanted, as well as being pominentely featured 
in the Hall Of Fame book, New Masters Of Photoshop and New Masters of Photoshop 2 (The only artist 
featured in both editions). Colin is also creator of the Photoshop Secrets Video training series (Photo-
shopCD.com). He is in high demand across the United States as a lecturer, presenting his Photoshop 
techniques to Photographers and graphics professionals across the nation. He has been a speaker at 
such conferednces as WPPI, Flash Forward, NVision, Photoshop World, PIDE, PIDE, DL Expo, Creative 
Suite Conference, Cre8, Create Chaos, Deviant Art Summit and many more. In 2012 Colin was the fea-
tured speaker for a Multi-City Tour (Route CS6) Sponsored by Adobe. Colin has consulted such compa-
nies as Adobe Systems, Edison International, Apple and Disney Studios. 

Jason Hoppe
An Adobe Certified Expert and Adobe Certified Instructor, Jason Hoppe has accrued 
more than 17 years’ experience in high-end production training, photo retouching, color 
correction, and creative workflow management. In fact, Jason has been performing 
high-end electronic production since the industry’s inception. Also during this time, 
Jason has taught prepress and electronic design to hundreds of Seattle-based creative 

professionals and aspiring designers in a variety of settings, including one-on-one tutoring, classroom 
instruction, live webcasting, and large group training. He currently teaches the Adobe Creative Suite 
at The School of Visual Concepts, Luminous Works and Seattle Central College and was the founding 
Instructor at creativeLIVE.
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INSTRUCTORS
Aaron Nace
�For over five years, Aaron Nace has been teaching photography and photo manipu-
lation to millions of users across the world at every skill level. Initially a hobbyist while 
earning a Bachelor of Arts degree in Industrial Design from North Carolina State Univer-
sity, Aaron’s expertise in Photoshop developed rapidly. His creative portfolio of retouch-
ing, compositing, and conceptual work grew quickly, and he soon became a globally 
recognized Photoshop master. His images have been published on MSNBC.com, AOL.
com, and The Huffington Post. Ever since, he has been committed to sharing his meth-
ods of creative conceptual photography both online and in-person.

In 2011, after three years of teaching online seminars to small groups of students, Aaron launched Phle-
arn.com, a photography and Photoshop tutorial website different from all the rest. Slated as the Internet’s 
photography personality, Aaron has single-handedly created hundreds of in-depth, high energy tutorial 
videos that have reached a community of millions of students worldwide. Aaron and the ever-growing 
Phlearn team make learning photography and Photoshop a dynamic, personal, and engaged experience 
for all of its users. Phlearn was one of CreativeBloq.com’s 10 Top Photoshop Resources in early 2013.

In addition to managing Phlearn, Aaron works as a professional retoucher, and his client list includes some of 
the world’s top photographers. He is on the board of the Midwest APA and has taught seminars at B&H’s Event 
Space in New York City, the Apple store on Michigan Avenue in Chicago, the Lowepro booth at the PhotoPlus 
Expo, and on numerous industry websites such as Fstoppers, [Framed], and Practical Photoshop Magazine.

Aaron is excited to continue making creative conceptual images, teaching and inspiring students at every 
level, working with amazing artists of all kinds, and becoming a resource for anyone interested in learning 
photography and Photoshop. To see his portfolio, check out www.aaron-nace.com, and to join the Phlearn 
community, visit www.Phlearn.com for new daily content. 

Jared Platt
Jared Platt is a professional wedding and lifestyle photographer from Phoenix, Arizona. 
Jared holds a Masters of Fine Arts in the Photographic Studies and a Bachelors of Fine 
Arts in Photography from Arizona State University and has been a professional photogra-
pher and college educator for the past 12 years and has been a speaking, debating and 
lecturing for the past 17 years. His attention to detail and craft make him a demanding 
photography instructor. Jared has lectured at major trade shows and photo conferences 
as well as at universities around the world on the subject of photography as well as work-

flow. Currently, Jared is traveling the United States and Canada teaching and lecturing on photography 
and post production workflow. Join him online for monthly “Office Hours” at www.jaredplattworkshops.com.

Jed Taufer
Jed Taufer has owned V Gallery - the art of photography (www.vgallery.net) with his 
wife, Vicki, for 15 years. He works for White House Custom Colour (www.whcc.com) 
and loves to spend time with his daughter, Purnima.
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INSTRUCTORS
Kevin Kubota
American Photo Magazine named Kevin Kubota one of the “Top 10 Wedding Photogra-
phers in the World”. His photos have been featured on the covers and within the pages 
of countless popular magazines and photography books. Kevin has been a featured 
presenter for Nikon and Adobe, and his work with the Nikon digital camera earned him 
a spot as a Nikon “Legend Behind the Lens”.

Kubota is an internationally recognized speaker, having presented for every major pho-
tographic convention in the USA. He created the popular “Digital Photography Bootcamp®” workshop 
which has been running successfully since 2002. He authored the book under the same name, now in 
it’s second edition, published by Amherst Media. Kevin shares over 2 decades of commercial and por-
trait lighting experience in his latest book, The Lighting Notebook, published by Wiley. The companion 
iApp, is available in the iTunes store.

Kubota Image Tools products have won multiple Hot One Awards as well as the Readers Choice Award. 
Kevin was personally awarded the 2009 Monte Zucker Memorial Humanitarian Award for social service 
through photography. 

Joel Grimes
In 1984 Joel Grimes graduated from the University of Arizona with a BFA in Photogra-
phy and soon established a commercial studio working out of Denver Colorado.

For over 27 years Joel has worked for many of the top advertising agencies and corpo-
rations across the globe for clients such as AARP, Abbott Labs, Archer Daniels Midland, 
Arizona Office of Tourism, AT&T, BC Lottery, Broncos, Comcast, Crown Royal, Febreze, 
Goldman Sachs, Hewlett Packard, Hyatt, Kodak, Naturella, Nikon, Pentax, Phillips 66, 

Philip Morris, Procter & Gamble, Pfizer, Qwest, Red Bull, Sony, Sturm Ruger & Co, United Global, USA 
Boxing, Visa, Volvo, and Xcel Energy. Over the years his assignments have taken him to every state 
across the USA and to over fifty countries around the globe.

In 1990 Joel produced his first coffee table book, ‘Navajo, Portrait of a Nation’ which received a number 
of photographic and design awards and produce an eighteen-month solo exhibit at the Smithsonian 
American History museum.

Driven by the creative process, Joel views himself as an illusionist, creating portraits larger than life. 
“There is no face on the planet that is the same, my vision as an artist is to capture that individual 
uniqueness through the photographic process.”

Joel is also an ambassador for the creative process by teaching workshops and lectures around the 
world. “I feel that by being an open book with my process I have an opportunity to inspire others to fol-
low their dreams and passions to create”.

Joel currently has a photo studio located in Old Town Pasadena California where he resides with his wife Amy. 
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“I rely on tools from Alien Skin throughout my work. Exposure provides
unique looks that take me in directions I never would have thought of.” PETER NGUYEN

Enjoy all the creative tools of fi lm photography, like discontinued fi lms, darkroom tricks, and 

lo-fi  camera quirks. Exposure 4 accurately simulates classic fi lms, like Kodachrome, Polaroid, 

and Panatomic-X. The result is a photo that looks like it was made by a human, not a computer.

Photo © 2013 Peter Nguyen 

© 2013 Alien Skin Software, LLC. All rights reserved. Exposure and Alien Skin Software are registered trademarks of Alien Skin Software, LLC. Kodachrome, Polaroid, and Panatomic-X are 
used for identifi cation purposes only and no claim is made to their trademarks.

Visit ALIENSKIN.COM to see gorgeous examples and try Exposure for free!
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The Photo Bundle gives you all of our photography 

software at less than half price. Our tools 

help your photography look natural, not digital. 

Visit AlienSkin.com to see beautiful examples 

and try the Photo Bundle for yourself.

“A client like Evander Holyfi eld inspires me to 

pull out all the creative stops. The tools from 

Alien Skin help me quickly explore ideas that 

would be tedious or impossible otherwise.”

— HERNAN RODRIGUEZ

“Successful people 
  make adjustments.”
   EVANDER HOLYFIELD
   facebook.com/TheRealDealHolyfi eld
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PHOTOSHOPTIPS

Switch your clone stamp blend 
mode to “Lighten” to reduce 
darkness under the eyes without 
completely eliminating de-
tail!  Blend modes are your best 
friends when retouching!

LINDSAY ADLER KHARA PLICANIC
1) My Million Dollar 
Super-Quick Quick Pho-
toshop Tip is: Ever get 
frustrated when your 
cursor seems to get 
a mind of its own and change from it’s regular, 
friendly self into an ominous looking cross-hair? 
Turn off your CAPS LOCK key. Poof! All better.

2) Not sure where the middle of your document 
is? Do you suck at math? Turn your rulers on 
(View>Rulers) and right+click to switch the mea-
surement to “percent.” Bam. No math required.

Layer Mask Preview: To make sure your layer 
masks are accurate, you can view them as a red 
overlay (like Quick Mask mode). To do it, click 
to activate the mask and then press the forward 

slash key on your 
keyboard: \. This 
temporarily lets 
you see the mask 
as a red overlay, 
enabling you to 
more easily see if 
you missed any 
spots.

Quick Before/After Comparison:
When working with a long Layers panel in Pho-
toshop, you can Option-click (PC: Alt-click) the 
bottom layer in the stack to temporarily turn off all 
other layers. To turn those layers back on again, 
Option-click (PC: Alt-click) the bottom layer’s visi-
bility eye again. This is a great way to see a quick 
before/after version of the image you’re editing.

LESA SNIDER

JED TAUFER
Here’s a quick tip: A cool way to manipulate light 
quickly and easily in Photoshop is to create a 
blank layer and change the mode to “Overlay”. 
Then, on the new, blank layer, you can “paint” 
shadow using a black brush or “paint” highlight 
using a white brush. Try this technique using 
lower opacities (5-25%) and a soft brush.

COLIN SMITH
Birds Eye View scrolling
Have you ever worked on a panorama or other 
really huge document? If you’re smart, you’ll per-
form most of your work at 100% view so that you 
have an accurate pixel rendering. Hold down 
the space bar to flick the image around and 
view a different portion. If it’s really big this can 
get tiresome, or you could even get lost in the 
Grand Canyon (Large photo of it at least). Hold 
down the spacebar and the H key. Click in the 
document window and the image will zoom out 
so you can see the entire document. Reposition 
the box and release, you have now completed a 
birds eye zoom of your document. Really cool, 
and brought to you by GPU acceleration.
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Making a Preset Bow to Your Wishes!

Are you a control freak?  Is a particular preset in your 
Lightroom preset panel doing something you don’t 
like?  Want to change the sepia tone color to 45 rather 
than 44?  No problem!  

Simply take a un-adjusted file, click on the preset you 
want to alter.  Pay attention to the sliders it is changing, 
and write them down on a piece of paper (if you need 
to, you can use CMD Z to undo and then click the 
preset again as many times as you need to to make 
note of all the sliders involved in making that particular 
preset).  Once it has applied its effect to the image, go 
in and re-adjust any sliders that have been changed to 
your liking.  When you are happy, right click the preset 
and choose “Update with Current Settings.”  

You will see the preset creation dialog box.  Click 
NONE at the bottom of the box.  Take out your list of 
sliders you saw moving when you applied the preset 
and check only those boxes (if you don’t want your 
preset to change a particular setting, don’t check 
the box).  When you are done, click UPDATE.  Now, 
that the preset is personalized to your discriminating 
taste, you may want to right click it an rename it so you 
know it is your very own.  Don’t settle for fixing slid-
ers that have been changed by an unruly preset ever 
again.  Fix the preset!

JARED PLATT
Capture Invisible Light and Straighten Up!

What do you do when you want a wide an-
gle scene-setter portrait, and need the light 
source close to the subject, but can’t hide 
the light source within the scene? Take two 
images: one with the light source perfect-
ly illuminating your subject, up nice and 
close. Then, without moving your subject 
or camera position, take another shot with 
the light source completely removed. If you 
hold relatively still while the light source is 
removed by your assistant, you don’t even 
need to be on a tripod. 

Next, take the two images in to Photoshop 
and put them on separate layers in the 
same document. If you poke the eyeball off 
and on next to the top layer, you’ll see that 
it’s likely the two images are not perfectly 
aligned. You could manually nudge and 
tweak them to align, but there’s an easier 
way. Select both layers then go to EDIT > 
Auto Align Layers…BAM! Perfect alignment. 
Poke the eyeball off and on again to validate 
your awesomesaucyness.

Finally, if your top layer is the image con-
taining the light source, simply add a 
layer mask to that layer, select a soft black 
brush, and paint over the light source on 
the image. Wherever you paint will reveal 
the clean image below it and everything 
will match up perfectly because you used 
Auto Align Layers. You may need to crop 
the image slightly where the edges shifted, 
but you’ll end up with a clean composite in 
about 60 seconds or less.

This tip has a companion video! See it here:
http://klnb.co/MLtip

KEVIN KUBOTA

BEN WILLMORE
Sharpening: With the top layer active, type Shift-Op-
tion-Command-E (Mac), or Shift-Alt-Ctrl-E (Win) to 
merge a copy of all the layers that make up your image 
into a new layer. Sharpen that layer with the sharpen-
ing filter you desire. Then to lessen the bright halos 
sharpening produced, change the blending mode 
pop-up menu at the top of the layers panel to Darken, 
duplicate that layer, set the duplicate to Lighten and 
then lower the Opacity of the duplicate layer to 50%.
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DAVE CROSS TOP 10 PHOTOSHOP TIPS
1. Create a New Layer Below
To create a layer underneath a 
layer, Command (PC: Control) 
click on the new layer icon with 
the layer selected. The layer will 
automatically appear below the 
layer that you selected.

2. Hide Layer Shortcut
Of course you can click on the 
eyeball icon to hide a layer, but in 
Photoshop CS6 there’s a keyboard 
shortcut to hide the current layer, 
by changing the opacity to 0. 
Press 00 to change the opacity to 
0% (therefore hiding the layer) and 
press 0 for 100% opacity (to show 
the layer)

3. Mask a Mask
If you have one or more layers that 
have Layer Masks that you want to 
mask even further, add the layers 
to a Group. Then add a Layer 
Mask to the Group to mask all lay-
ers in the Group at once. Now you 
can edit both the Group Mask and 
the individual Layer Masks.

4. One document, Two Views
When we zoom in really close to 
work on details, sometimes we 
forget how much smaller the final 
product will be. One solution is to 
use the command Window>Ar-
range>New Window for [name of 
your document]. This will create a 
second window of the same doc-
ument. Then go to Window>Ar-
range and choose one of the tiling 
options. Zoom in on one view but 
keep the second view at the “final” 
size. Any changes you make in the 

zoomed in view will also show in 
the actual size view.

5. Open a flat version
If you want to temporarily open 
a flattened version of a layered 
document (for example, to open it 
more quickly or to show to some-
one), hold down Option (PC: Alt) 
and Shift when you open the file. 
It will “Read the Composite Data 
Instead” and open a flattened 
version – under the same name. 
Just be sure not to save the file as 
a flat psd!

6. Overlay and Normal Shortcuts
There are keyboard shortcuts 
for all of the Blend modes, but 
when I’m working on layer masks, 
there are two I use all the time 
for my Brush: Option-Shift-O 
(PC: Alt-Shift-O) for Overlay, and 
Option-Shift-N (PC: Alt-Shift-N) for 
Normal. This is very useful when 
you need to switch between Over-
lay and Normal mode while you’re 
painting on a mask.

7. Puppet Warp as a Smart Filter
Even though Puppet Warp is found 
under the Edit menu, you’ll have 
much more control if you first con-
vert your layer to a Smart Object. 
This way, Puppet Warp will be 
applied as an editable Smart Filter.

8. Smart Object instead of Stamp 
Visible
For years I’d been telling people 
to press Command-Option-Shift-E 
(PC: Cntl-Alt-Shift-E) to make a 
merged copy of all your layers. 

The only problem with that method 
is it’s a snapshot, so if you change 
the underlying layers, the merged 
version will not change.

Instead select all the layers and 
convert to a Smart Object. Now 
you can work on that layer, but still 
have access – live – to all the orig-
inal layers, just by double-clicking 
on the Smart Object.

9. Targeting Layers w/Shortcuts
To activate the layer above or 
below the current layer in the 
layer stack, use these shortcuts: 
Option-[(PC: Alt-[) targets the 
layer down one layer in the stack. 
Option-, (comma) (PC: Alt-,) tar-
gets the layer at the bottom of the 
stack. Option-. (period) (PC: Alt-.) 
targets the very top layer. These 
shortcuts are particularly useful 
when recording an
action, so that the name of the 
layer is not recorded.

10. Tricks with Guides
This is actually a tip that works in 
Illustrator and InDesign as well as 
Photoshop: If you’re dragging a 
guide off the ruler onto the image 
window and you decide you want 
it in the opposite direction (hori-
zontal vs vertical), don’t let go of 
the mouse –press and hold Option 
(PC: Alt) to change the guide 
direction. In Photoshop you can 
change the direction of an existing 
guide: with the Move tool
selected, press Option (PC: Alt) 
and click on an existing guide to 
change its direction.
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GET PERFECT EFFECTS 4 
PREMIUM EDITION FOR 
FREE! ($99.95 VALUE) 
O�er only valid to creativeLIVE 
PHOTOSHOPweek participants 
through 3/2/13.
www.ononesoftware.com/creativelive

Get 15% o� any onOne Software product 
at www.ononesoftware.com/store. 
Coupon code CLive15. Expires 4/1/13.

Create images with impact quickly 
and easily with Perfect E�ects 4 
—image-editing software designed 
specifically for photographers like 
you. 400+ one-click e�ects, powerful 
tools, and live previews let your 
creativity shine while spending less 
time at your computer.

Add e�ects to create popular looks, 
such as HDR and vintage, paint in 
radiance, detail and texture, and 
much more to create the images 
you envision.

CREATE IMAGES WITH IMPACT





Ideal for in-studio or on-location work
Mount your technology where you want it when you need it

Integrated Workstation Solutions




